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After the FairyCut software installation a new 
icon will be created on the Windows desktop, 
to run the program double click the FairyCut 
icon

Chapter 1: Starting out

Your FairyCut software is now installed and you are 
impatient to discover the many capabilities of the software. 
Your creative energy overflows, but you will need a certain 
time to get acquainted with the software and the equipment. 
The more you will explore the possibilities and functions, the 
easier it will be for you to create and realize your future 
projects.

A screen identical to this will appear:

Options:
A) Create
B) Open
C) Learn

: Creation of a new blank document
: Selection and opening of an existing document
: Watch online video



Overview of Basic Commands

Document Bar

New Documents: Open a new page (Ctrl + N)

Open:  (Ctrl + O)Select and open a document

Save: Save a document (Ctrl + S)

Document Bar

Tool Bar

Color Palette

Zoom Bar

Working Screen

Function Bar



Cut: Cut selected element(s) (Ctrl + X)

Copy: Make a copy of selected element(s) (Ctrl + C)

Paste: Insert into your page the last element(s)
cut or copied  (Ctrl + V)

Print: Print on the selected printer.your design 

Redraw: Clean (Refresh) your working screen

Logos: Open the logos and shapes catalog window.

Import: Select and import a document file or image

Redo: Redo the last action(s) you undid. (Ctrl + R)

Undo:
editing action when possible. The name of the 
command changes, depending on what the last 
action was.  The Undo command changes to 
Can't Undo on the menu if you cannot reverse 
your last action.

Use this command to reverse the last 



Create a new blank document

A new screen appears “Page Size”
Now you can select your cutting mat and click “Ok”

The “working screen” opens. The cutting mat represents your 
page according to the selected dimension and orientation. You 
will also see the tools, the color palette, a function bar and, on 
top of your screen, the document bar. 

Working Screen



Left toolbar

1- Select Elements: Tool for selecting of one or more element(s). 
(Select, move, and resize an element(s))

2- Move Point: (F9) The manipulation tool is useful to move 
points or to convert an arc into a line or a line into an arc.

3- Text Tool: To use, select “ tool  then move your cursor on 
the page and click. Type in your text.

text ”

4- Justification: Brings up the justification tool bar to align the 
text and the various elements selected to the center, left, right, top 
or bottom. 

5- Kiss Cut: Select to draw a dashed line instead of a solid line. 
The “Kiss Cut” is great to generate folded lines (crease tool) 

6- Segment: Use to draw lines automatically connected. To use 
this tool, select it from the Tool Bar, move the mouse on your 
working screen, click and drag. Release the mouse button to 
create your first line, move the mouse and click to connect to the 
first line continue this action.

7- Replace by one segment: Use to replace curves, corners and 
lines with a straight line.

8- Arc from a path: Use to draw connected curves.

9- Replace by an Arc: Use to replace lines, corners, curves with 
a smooth curve.

10- Free Hand Draw: Free hand draw traces a smooth path and 
closes the path by connecting the two extremities of your path.

11- Oval: Use to draw ovals or circles.

12- Rectangle: Use to draw rectangles or squares.

Note:
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13- Join selected objects/Weld: Use to join two or more 
overlapping objects together.

14- Substract selected objects/Weld - : Use to substract two or 
more overlapping objects together.

18- Image Contour: To create exterior or interior contour of an 
image allowing to cut the contour created.

17 Zoom window: Use to zoom in closer to your page. 

16- Erase: Use to erase line(s), curve(s) picture. (F5)
You can also use the “Delete” from your keyboard.

15- Transparent Group: Group two or several objects to create a 
single object, the overlapped areas creates transparencies. 

17

The selection tool  

http://fairycut.com/videos/SelectionBasic/selectiontoolsBasic.swf


 13-Join selected objects/Weld: Use to join 
two or more overlapping objects together.

14-Substract selected objects/Weld  : Use to 
substract two or more overlapping objects together.

1     2   3    4   5     6    7   8    9   10 11  12  13 14   15  16 17 18 

Welding

Weld project 

http://fairycut.com/videos/WeldProject/Weld%20Project.swf


To use this feature:

1) Select the image to be 
outlined or inlined

2) Click the Contour Cut icon 

3) Using the sliding button to: 
a) Adjust the path tolerance, 
b) Adjust the path smoothness
c) Adjust the width of outline or 
inline.

18- Image Contour: To create exterior or interior 
contour of an image allowing to cut the contour 

Contour Cut 

a

b

c

http://www.fairycut.com/videos/View-One.aspx?video_id=12


7- Zoom Object: Use this zoom to fit any selected object(s) 
or element(s) on the screen, just select object and click the 
zoom icon.

6- Zoom Previous: Change the zoom view to the last view 
you had it.

5- Construction points: View construction point of a 
selected object.

4- Wire frame: An outline view of a drawing that hides fills but 
displays contour lines, view your work without fill color.

3- Grid: The grid is a series of dots that you can use to 
precisely align and position objects in the drawing window. 
You can set the distance between the grid dots by specifying 
the spacing. 

2- Unlock: Select the unlock icon and click the object to be 
unlocked.

1- Lock: Select an object or many objects, click the lock icon, 
the object(s) occupies a fixed position and not maybe moved 
or selected. You can lock object(s)to prevent accidental 
changes to its objects. When you lock an object(s), you cannot 
select or edit it.

8- Zoom All: View your entire page your work fill the whole 
screen.

9- WEB video page: Open the FairyCut web site video.

10- Color sheme :Change the current palette using selected 
image.

11- Rhinestone: Open the rhinestone transformation window.

Bottom Tool Bar

http://www.fairycut.com/videos/


Draw segment from a selected path

Draw segment

Break and move 

Replace by a segmentpoint

Change line to vertical or horizontal

Segment floating bar

To display or hide the Segment bar, open the Segment bar 
command in the View menu.
The Segment bar allows you to:

To move the bar to any location on the screen, use the 
mouse to drag it to the desired position. To hide it, click the X  
on the top right corner.

Arc floating bar

To display or hide the Arc bar, open the Arc bar 
command in the View menu.

The Arc bar allows you to:

Draw arc from a selected path

Draw arc

Replace by an arc

Change segment to arc

Correction tools

http://www.fairycut.com/videos/View-One.aspx?video_id=7


Curve floating bar

To display or hide the Bezier bar, open the Curve bar 
command in the View menu.

The Bezier bar allows you to:

Do a Free hand drawing

  Do a Free hand drawing from a selected path

  Snap points

Unsnap point 

To move the bar to any location on the screen, use the mouse to 
drag it to the desired position. To hide it, click the X  on the top 
right corner.

Polygon floating bar

To display or hide the Erase bar, open the Erase bar command in 
the View menu.

The Polygon Arc bar allows you to:

Draw a rectangle

Draw a polygon

Draw a star

Draw a arrow

To move the bar to any location on the screen, use the mouse to 
drag it to the desired position. To hide it, click the X  on the top 
right corner.



Justification floating bar 

To display or hide the Justification bar, open the Justification bar 
command in the View menu.

The Justification bar allows you to:

Align left

Align right

Center

Vertical

Horizontal and vertical

Align top

Align bottom

Center to the page

Align to guide line

Mirror Left/Right

Align left on the page

Center on the page

Align right on the page

Space justification

To move the bar to any location on the screen, use the 
mouse to drag it to the desired position. To hide it, click 
the X  on the top right corner.



The Zoom bar allows you to:

Zoom previous

       Zoom selected

       Zoom All

       Zoom Page

       Zoom small

Zoom floating bar 

To display or hide the Zoom bar, open the zoom bar command in the 
View menu.

To move the bar to any location on the screen, use the mouse 
to drag it to the desired position. To hide it, click the X  on the 
top right corner.



Erase floating bar

To display or hide the Erase bar, open the Erase bar command in 
the View menu.

The Erase bar allows you to:

Erase an element

Erase by color

To move the bar to any location on the screen, use the mouse to 
drag it to the desired position. To hide it, click the X  on the top right 

Color floating bar

To display or hide the Color bar, open the Color bar command in 
the View menu.

The Color bar allows you  to:

Color element.

 Open the gradient color

 Unfill selected element 

Fill selected element

Sort the selected element by size

To move the bar to any location on the screen, use the mouse 
to drag it to the desired position. To hide it, click the X  on the 
top right corner.

Erase and close path



From the Document Bar, Tools menu expand 
and select Outline.

Outline:

The window transformation contains four tools, the first tool 
allows to create external and / or  internal contours around 
a text or a logo. You can create one or more spaced 
external contours of adjustable thickness. 

Regrouped additional tools
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Thickness: Select the thickness of your outline. Always use 
a low value like 0.10 or 0.25. ( 0.25 = 1/4 inch) 

Number: Select how many outlines you want. 

Outline / Inline: Outline is towards the outside of the design 
object while inline is towards the inside of the design object. 
Remember that the number of inline contours is limited by 
the size of the object. 

Contour: This function automatically welds the 
objects, select contour to make any overlapping outlines 
automatically weld together.

overlapped 

Gradient: Generate a color background made up according 
to the gradient of filling selected.

Break Text: This activated function separates the original text 
from the outline created when not activated, the initial text and 
outline created are grouped units and inseparable. 

Sort: Arranges  order of the outlines generated in 
order to show the smallest object on top of the pile.

stacking

Fill Color: Displays the current outline color selected.

Corner Style: Select from three model styles of generated 
outline corners.

Apply: Apply your current setting to generate outline(s).



Right Tool Bar

Open the shapes librairy

Draw free drawing

Tracing bitmap (Convert 
image to vector)

Send your project to your 
cricut  

To write a text

http://fairycut.com/videos/view-one.aspx?video_id=3
http://fairycut.com/videos/View-One.aspx?video_id=6
http://fairycut.com/videos/View-One.aspx?video_id=10
http://fairycut.com/videos/View-One.aspx?video_id=5


TrueType fonts: Click the TrueType button to view and 
select all TrueType fonts installed on your computer.

FairyCut fonts: Click the Fairycut button to view and 
access all Fairycut fonts especially made for scrapbooking.

To preview what your text will look like in different fonts. 
You can type your text or you can use the selection tool 
to select a text before opening the Text & Fonts window.

Text Box: Type, view and edit text.

OK: Applies changes to the text and closes the font 
window.

Cancel: Close the font windows without applying 
changes to the text.

Font Height: You can change the height of your text in 
the Height window. The height of the font is defined with 
the capital letter N. 

To write a text
The most-often used functions appear on the right side of 
your working screen. Click the Text & Fonts button icon on 
the right to open the Fonts Menu window.
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 Create shape & text 

http://fairycut.com/videos/Text/Text.swf


Text Edition

This option allow you to write and edit text. You can also Paste 
texts from Word etc to this screen. You can change the size, style 
and justify your text.

Write text to path
To write text on a given path. 
·  Write a text and draw a  curve. 
·  Select both the text and the curve. 
·  From the Text menu, click on Fit text to path. 
· Select your position, direction, spacing 
  between characters etc…. 
  
 Your text selection will closely follow the curve. 



Shapes: Click the button “Shapes” to open the 
window, use the pull-down bar 1 to see the available 
shape categories, select a categorie. Use the pull-down 
bar 2, click on the desired shape to insert into your 
working page.

Shapes 

From the working screen “select a 
shape” you can:

1) Add or insert a logo selected  
with the working page
2) Erase one or several logos
3) Search for a logo by using the 
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Auto-Path: Open a window for the 
conversion of a bitmap image (pixels) 
into a cutting logo. For more 
information about vectorization.

Free HAND: Click the “Free HAND” 
button to open the Free Hand window. 
You can select black or white brush color 
and four different brush sizes. Click the 
OK button, begin to hand draw on your 
working page.



Cut Project: (F10) The Cut project 
button opens the cutting window 
panel to cut or draw your project. 

Video Cut your first project:

http://fairycut.com/videos/View-One.aspx?video_id=5


2- Rotate: Rotates your entire work.

6- Speed: The cutting speed.

5- Multicut  The number of times the cutter is going to cut 
the same object. To cut thick media like chipboard, you can 
use two or three passes.

 (Note You need to select the pressure from your Cricut)

To open the control cutting panel, 
click the “Cut Craft” button or press 
F10 from your keyboard. 

More on Control Cutting Panel

1- Selected object: Displays and cuts one or many selected 
objects. Select object(s) before you checkmark “Selected 
object”.

3- Weeding: Cut a square around your drawing, useful to cut 
vinyl stickers.

4- Mirror: Mirror function can be done inside the software. 
Selected from the Control Cutting Panel, this function mirrors 
your entire work. Useful when you are cutting iron-on transfer 
material. 
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8- Option  

Section 2 Advance options

1

1- Knife Offset : Select this option to make sharp corners.  

2

2- Print and cut calibration : Select to calibrate your 
cricut for print and cut
.
First add a sheet of paper and use the     cut an calibrate 
rectangle. Measure the length X and Height
Y. Enter your measure and press Ok.

3

3



Color Palette

Pen line color

Pen color = Black
Fill color = White

Pen color = Black
Fill color = Red

Fill object color

Pen Color: The pen color or the edge of an object is what is 
cut out; it does not affect the fill color or color inside an 
object. (brush color). 

Fill Color: The fill color or color inside an object. (brush color). 

B

BrushBrush

P

PenPen

Palette: By selecting an object and moving  
the mouse cursor on a color of the pallet, 
you will obtain a fill color if you press the 
left mouse button, and a pen color if you 
use the right mouse button. 

Color Box: Moving the mouse cursor over 
a color of the color box, you can select a 
pen or fill  color for any selected object. 



Brush & Pen Slider: These bars show what 
colors are currently selected for your brush 
(fill) and pen color (border). Clicking the “X” 
boxes will make the fill color or the pen color 
invisible. “X” are colored in red to show that 
they are not visible.

Pen Style: Use the suitable button to change 
the line pen style, solid line, dotted line or 
invisible line. The thickness of a line can be 
modified by using the sliding button or by 
typing the desired value in the window.

Pen Style Transformation: Brings the 
transformation window with three tabs: 
scissors,rhinestone,lattice

RhineStones: Open the RhineStone window  which allows to 
create from a text, from an image or from a vector logo the 
stencil of the beads position. Beads are equally distanced on 
the selected path object. Specify the desired size and distance. 
Created objects can be edited.

Lattice: Open the lattice window.

Scissors: 12 scissor models are 
available; by using the pull-down bar, 
select the scissor model, then use the 
slider to change the size of the model.
Click the “Apply” button.

                 
                VIDEO:Scissor Effect 

http://fairycut.com/videos/View-One.aspx?video_id=8


Scissors tools

1

2

3

1- Select size.

2- Select your scissors style.

3- Apply your scissors  settings to your design (Objects in selection).

Scissors tools

http://fairycut.com/videos/View-One.aspx?video_id=8


Create a beautiful lattice design out of any shape using the Lattice 
feature under the Tools button on your Color Palette.

 

1. Height: Adjust the height of your lattice design.
 
2. Spacing: Change the spacing of your lattice design.
 
3. Angle: Increase or decrease the angle of your lattice by moving the 
slider bar left to decrease and right to increase. 

4. Preview: Preview the lattice on your design. You will need to have 
your design filled in with color to be able to preview the lattice design. 

5. Apply: Apply your lattice settings to your design. Your lattice will not 
be applied unless you select Apply! 
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Lattice video

http://fairycut.com/videos/View-One.aspx?video_id=11


1. Size: Rhinestones come in many different sizes and 
are usually indicated by a number followed by "SS" (short 
for "Stone Size"). Match the size of your rhinestones to 
the sizes listed so that you can make a perfectly sized 
template.
 
2. Stone Size: Stone size will display the exact size of 
your rhinestone.
 
3. Erase Original: When this box is selected, the original 
path of your design will be erased and replaced with your 
rhinestone template. Typically you will want to keep this 
box check marked. Make sure you have your design 

You can create rhinestone design templates out of any vector 
image by using the Rhinestone Window!

Rhinestone Window 

Rhinestones
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Rhinestones

http://fairycut.com/videos/View-One.aspx?video_id=2&more_interested=true


4. Spacing: The spacing in between each rhinestone. You 
can change the rhinestone size by clicking and typing in 
the box. You will want a spacing that is at least 50% of the 
rhinestone's size.
 
5. Rhinestone Color: Choose a rhinestone color to be 
displayed on your template that will help you visualize 
how your final design will look.
 
6. Fill: When this box is selected your design will be filled 
with rhinestones rather than just an outline around your 
design.
 
7. Lasso Selection: Select multiple elements (like 
individual rhinestones) at the same time by drawing a 
lasso around them.
 
8. SS Info: Gives you information about the size of the 
stones in your design and how many stones are used in 
your design. 

9. Apply: Applies your rhinestone selections to your 
design! 



Multiply
With the selection tools use use the right mouse button
and select MultiplyYou can control the number and spacing 
between each copy. 

You can control the number and spacing between each copy. 

The multiply selected elements dialog box will be displayed.
Enter the number of desired copies, select the horizontal and 
vertical distances between the copies and the original, and the 
orientation of the copies, then press Enter or click OK.



Chapter 2: Making your first project. (Part A)

Step 1

Step 2

Step 3

Double click the FairyCut icon on the Windows 
desktop. 

This screen should appear, double-click “CREATE”. 

A new screen will appear where 
you can select your page size 
or define a new working page 
and choose metric or English 
units.

Note: You can change the 
dimensions of your working 
page anytime.

This part is divided into two steps: part A is for new, 
inexperienced users, and allows for progressive learning. 
Once the basic technique is mastered, part B will let you use 
all the capabilities of the software.



Step 4

Step 5

Step 6

Select the page size you wish to use and select “Ok”.

Click the Close button to close the “Tip of the Day” window.

This is the “working screen”.



Step 7

Opening a design from the “Shapes” button.

b) Click on the desired shape to insert 
into your working page.

c) The selected shape appears in the bottom left corner 
of your working screen. Click the flower.

a) Click the button to open 
the Shapes window, use the pull-down 
bar to reach logo 9-A.The default size 
is “Medium”. Change size to “Big”.

“Shapes” 



Step 8 Let’s add a simple text

a) From the Tool Bar on the left side of your working 
screen, select T, the Text icon.

b) Once selected, the T icon becomes depressed; 
move the mouse on the working page (the cursor is 
similar to a capital I), and click on the place where 
you wish to begin the text.

c) Type in “Love”, the text should appear on your 
working screen.

d) Select “Select Elements” from the Tool Bar.

e) Click on “Love”, eight small black boxes appear around 
your text, this indicates that the object Love is selected

f) Use the right hand top handle to resize the ”Love”  object. 
To do this, place the mouse cursor over the right hand top 
handle, you’ll notice that the cursor changes to a double-end 
arrow.         



h) By using the Select Element tool, move and resize 
objects on your screen in order to obtain the appearance 
of our drawing. 

Click on the “Cut Project” icon, this 
will open the Cutting Control Panel.

g) When you place the mouse cursor over a selected object 
like “Love”,the cursor change to an X with arrows symbol.       
When it appears, click and drag the selection near the top of 
the heart object. 

I) Press the weld button.  



Select the right pressure from your Cricut machine.

Select the speed from the cutting panel low, medium or fast.

Install your cutting mat and press load paper. 

Press Cut Project.  

Congratulations, you have just finished your first project.

To save your work, go to Document Bar, File, Save 
this opens the “Save as” menu. Always save your 
work in the same directory.



Chapter 3: Graphics source and Vectorization

When digitizing your image - use the scanner functions to 
enlarge the image as much as possible. The larger the 
image, the better the conversion will be.
You can scan in color at 256 colors, 8 bit, 16 bit, or 24 bit.

1- You can import graphics into you FairyCut 
software by using your Import button from 
the document bar. You can use File Menu, 
Import, Image. (Ctrl + i).

2- From another program showing on the screen
or from a Web site, you can use the right mouse button to 
copy the selected graphic and paste it afterward on your 

 scrapbooking working screen.. Use the right mouse 
button to copy or paste a graphic or use the keyboard (Ctrl 
+ C) to copy and (Ctrl + V) to paste.

a graphic , 

Fairycut



To begin the automatic color vectorization

Step 1: Import an image or scan an image.

Step 2: If your image shows gaps, use our interpolation tool, 
allowing to increase the size of your image.

The quality of your image will affect the results. An image 
taken from a Web site is often of poor quality,  and most of 
the time is too small to generate a good conversion.
If your image presents gaps:
1) Size of the image is lower than 2 inches.
2) Visual quality is 72 or 96 dpi
3) Image shows stairlike borders.



From the Image Menu select Vectorization / Automatic 
Enhance Curve.

Or simply,
click Auto Path button.

The resizing (blow up) factor  of the image maybe from 4 to 
20 times the original size. If your image size is 1/8 inch, a 
factor of 20 will be normal.

Step 3: To begin the automatic color vectorization.



Step 4 Consists in analyzing image to be converted. We 
can only trace in Bézier curves, we can force the 
quantity of curves and arcs, we can force the creation of 
sharp corners and lines.

Detect Intensity: Allows to increase or to remove colors 
or tints or allows to increase the tint or to increase 
strength of one or several colors.

Make Vectorization: The magic wand allows to vectorize 
the drawing.

Apply on Selection: After vectorization you can select 
objects. The selected objects can be transformed into 
curves or into segments to obtain square corners. 

Color Resolution: Allows to reduce the number of bits by 
successive steps from 24 bits to 1 bit per pixel. This tool 
transforms an image in a black and white picture.
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Step 1



Three easy steps

Step 1: Visually this image 
contains a strong 
percentage of curves. Let 
us use “Enhanced curve”.

Step 2 : Use the 
“Detect Intensity” 
tool  and use the 
first slider to 
increase or decrease the 
intensity of colors.

Use the “Color 
Resolution” tool 
and use the down 
arrow to select 1 
bit,  decreasing  colors to 1 
bit pixel ( Black & White). A 
black and white image 
generates better quality 
during vectorization.

Use these parameters:
Bits per pixel = 1
Dither method = None
Palette = Fixed Palette
Color Order = Blue-Green-
Red.

Display mode:
1:1 real scale
Full screen( see full image)

Step 3:



Use the “Magic Wand” and click on the image to 
be converted. 

After vectorization, objects can be modified by using others 
conversion parameters. If a visual analysis of vectorized 
objects shows that one or more converted objects need  
squared corners, only use the “Select Elements” tool, select 
one or more objects, click the option “Enhanced corner” and 
click the button “Apply on selection”.

“Enhanced corner” forces objects to display sharp corners; if 
you use “Enhance curve” it forces objects to display curves, 
which means sharp corners become rounded. 

Also good to vectorize text.



8

7

6

5

4

3

2

1

1. Transform: Indicates which 
tool is selected and used.

2. Position as X and Y: 
Represents the position of the 
selected object. On the photo 
we see a position giving to X 
a position of 2.5 and giving to 
Y a position of 5. The left 
bottom screen corner 
represents the position 0,0. 
You can modify these values 
by typing the desired values 
in the window. Scroll buttons 
can be used.

3. Angle:  This represents 
the rotation angle in degrees  
that you wish to rotate an 
object or the inclination 
(slant) angle.

4. According to: You can select the rotation axis or the 
mirror plan to make a transformation.

5. Increments:This represents the rotation angle 
that you wish to rotate an object or the inclination (slant) angle.

in degrees 

6. Cancel: This cancels (undo) the last action.

7. Duplicate: Before selecting “Apply” you can select 
“Duplicate” to create a copy of any selected object or groups.

8. Apply: Apply the selected transformation to the selected 
objects or groups.

Press the letter H from your keyboard.

Note: The transformation tool measures the selected object, it 
is the measure of the box of the selected objects. Not 
recommended for text height.

The transformation tool is specially used to modify or to 
compare position, height, width, condensation, slant, mirror  
effects, rotation and engraving functions of any selected 
objects or groups. This exceptional tool will facilitate your 

Chapter4: Transformation window



Change Position

Use this option to move the drawing to new X and Y coordinates.

Select Change Position from the Transform submenu, and 
FairyCut will open the Transformation dialog box. Enter the 
new X and Y coordinates and click Apply.

You can also open the transformation bar pressing X or Y on 
keyboard.
 
Note : This command is unavailable if no data is currently 



Change Height

Use this option to change the height of the drawing. 

Select Change Height from the Transform submenu, and 
FairyCut will open the Transformation dialog box. Enter the 
new height and click Apply.



Change Width

Use this option to change the Width of the drawing. 

Select Change Width from the Transform submenu, and FairyCut 
will open the Transformation dialog box. Enter the new width and 
click Apply .

You can also open the Transformation dialog box with the right 
mouse button or pressing letter L on the keyboard.

Note : This command is unavailable if no data is currently 
selected.



Condense

Use this option to condense the drawing. 

Select Condense from the Transform submenu, and FairyCut 
will open the Transformation dialog box. Enter the new width 
and height and click Apply.

You can also condense the drawing with the mouse. Once the 
drawing is selected click on one of the little squares and drag 
your mouse until the desired size is reached.
You can also open this option pressing the letter C on the 
keyboard

Note : This command is unavailable if no data is currently 
selected.



Italic

FairyCut
FairyCut

Select Make italic from the Transform submenu, and FairyCut  will 
open the Transformation dialog box. Enter the italic value and 
click Apply.

You can also open this option pressing the letter I on the keyboard

Note : This command is unavailable if no data is currently 
selected.



Rotate

Use this option to rotate the selected elements. 

Select Rotate from the Transform submenu, and FairyCut  
will open the Transformation dialog box. Enter the rotation 
angle, select the base point, and click Apply.

You can open this option pressing the letter R on the 
keyboard.

Note : This command is unavailable if no data is currently 
            selected.



Mirror

Use this option to create a mirror image of the selected object. 

Select Mirror from the Transform submenu, and FairyCut will 
open the Transformation dialog box. Choose the base point 
and click Apply to reverse the object as if seen in a mirror. If 
you choose the Duplicate option you will have a mirror copy 
of you drawing.

You can also open this option pressing the letter M on
the keyboard.

Base point



Single Line Rhinestone

1) Single line font and single line italic font
2) Regular Sign Max fonts and TrueType fonts 
(Contour)

Click the Text & Fonts button icon on the right to open 
the Fonts Menu window.

Select a single line font among available selections:
- Engineer
- Helvetica Medium Blueprint

Step 1

Step 2

Step 3

Step 4

Check mark the box “Edit spacing after creation”

Type your text in the “Text box edition”

By default height is 1 inch, if you need to change 
type wished height and click the button OK

1

2
3Fairycut
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By using the right arrow, add more space between letters 
a space of 0,25 (1/4) inch is recommended.

Apply this function to convert your text in paths every 
letter becomes independent the others.

Click the button Rhinestones from the Bottom 
Tool Bar.

To reach the window Rhinestone 

Step 5

Step 7
 

Step 6



Text: Lisa.
Font: Helvetica medium single line.
Height: 1 inch.

Use these parameters:  
1- Rhinestone beads size is 6 SS = 0,078”.
2- Spacing between beads is 0,04” this value must be. 
50% and more of the beads size.
3- Erase original path is selected.
4- Click Apply button.

Apply Rhinestone function to your text.Step 8:

Contour Block Rhinestone

Regular FairyCut fonts and TrueType fonts
(Contour fonts)

Step 1

Steps 2, 3, 4, 5, 6 (same as page 1)

Click the Text button icon on the right to open the
Fonts Menu windows.

From the Fonts Menu windows select  fonts 
button, and use Helvetica Medium. Type in your text in the 
Text  box edition etc...

Fairycut

1

2

3



Text: BLO
Font: Helvetica medium.
Height: 1 inch.

Use these parameters:  
1- Rhinestone beads size is 6 SS = 0,078”.
2- Spacing between beads is 0,04” this value must be 
50% and more of the beads size.
3- Erase original path is selected.
4- Click Apply button.

Contour Script Rhinestone

Script FairyCut  fonts and TrueType fonts
(Contour fonts)

Click the Text button icon on the right to 
open the Fonts Menu windows.
 

From the Fonts Menu windows select FairyCut fonts 
button, and use Helvetica Medium. Type in your text in 
the Text  box edition etc...



Click the button “Shapes” to open the 
Shapes window, use the pull-down 
bar 1 to see the available shape 
categories, select a category. Use 
the pull-down bar 2, click on the 
desired shape to insert into your 
working page.

1

2

Shapes Rhinestone

Click hape to your 
working screen. The selected shape appears in the bottom 
left corner of your working screen.

on a s  like clover or heart insert on 

C Shapeslose the  window, click red X top right hand corner. 

Select the select element tool, click on the heart object to 
select it; eight black handles appears.

From your keyboard press the letter H to open the 
transformation window.

Type in H value 4 and 
click Apply button
Close the transformation 
window using the X.

Using the color palette hide the fill color.



Text: SCR
Funtime Font: Freestyle Script
Height: 1 inch.

Use these parameters:  
1- Rhinestone beads size is 6 SS = 0,078”.
2- Spacing between beads is 0,04” this value must be 50%. 
and more of the beads size.
3- Erase original path is selected.
4- Click Apply button.

Fill Fonts Rhinestone
Script FairyCut fonts and TrueType fonts
(Fill fonts)

Step 1

Steps 2, 3, 4, 5, 6 (same as page 1)

Click the Text button icon on the right to 
open the Fonts Menu windows.

From the Fonts Menu windows select FairyCut fonts 
button, and use Helvetica Medium. Type in your text in 
the Text  box edition etc...

Text: FIL
FairyCut Font: Helvetica Med
Height: 2.0 inches.

Use these parameters:  
1- Rhinestone size is 12 SS 
= 0,122”.
2- Spacing between beads is 
0,08” this value must be 70% and more of the beads size.
3- Erase original path is selected.
4- Check mark Fill option.
5- Click Apply button.



Use these parameters:  
1- Rhinestone beads size is 6 SS = 0,078”.
2- Spacing between beads is 0,06” this value must be 70%. 
and more of the beads size when we fill an object.
3- Erase original path is selected.
4- Check mark fill.
5- Click Apply button.

Fill a figure with rhinestones. 

Click the button Rhinestones from the Bottom 
Tool Bar.

Use these parameters:  
1- Rhinestone beads size is 12 SS = 0,122”.
2- Spacing between beads is 0,06” this value must be 50% 
and more of the beads size.
3- Erase original path is selected.
4- Uncheck fill.
5- Click Apply button.



Rhinestones window

From the  ool ar, click the Rhinestone button.Or
From the palette of colors, click the tools button, this opens a 
window and click the Rhinestone tab.

Bottom T B

Rhinestones: 
and select Rhinestones. 

From the Document Bar, expand Tools menu 

1) Select the path or object.
2) Select the stones size.
3) Use a spacing of at least 50 % of the stones size.
4) Erase original path(s). 
5) Check mark Fill if you wish to fill completely the figure. 
6) Click the Apply button.

2
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Designing from scratch is very easy and interactive. 
With FairyCut you  can upload your own images, add 
printed or beaded text and graphics..  Adding beads or 
rhinestones in different shapes, colors and sizes from 
our Rhinestone menu. You have the ability to manipulate 
rhinestones beads,  copy, paste, rotate, mirror, delete, 
replace, change size, spacings, print shapes, use 
beaded texts and much more.

16 SS (0,153”) = 

4,0mm and spacing 

12 SS (0,122”) = 

6 SS (0,078”) = 

Tools developed specifically for the Rhinestone selection

From the Document Bar, expand Tools menu and select 
Selection. 

Select: Tool for selecting of one or more element(s). 
Maybe uses with Hold down Shift key and click on each 
object you want to select. You can also select one or 
more objects by dragging around the object or objects 
the selection tool.



Invert selection: Need to select one or several not selected 
objects and to remove of the selection the object or the 
selected objects.

Select similar color: Need to select all the objects. 

Select similar objects: Select an object, use Selection / 

Select similar objects. All text or Rhinestone objects are 
selected dependent on the object initially selected.

Deselect all: Keyboard shortcut Ctrl key + letter D.

Select all: Keyboard shortcut Ctrl key + letter A.

Just to use the lasso to contain elements to be selected.



From the Tool Bar click on Select Element icon 
this open the selection bar. 

From the Selection Bar click on Lasso icon.

From the Document Bar, expand Shape menu and 

Heart size: 
Star size: 
Star:
Full Path distribution
Spacing:
Distance:

5,0”
0,375” (3/8”)
on top layer

0,133”
0,25” (1/4”)

Fit objects on a path

1) Select the path and the object(s) to be distributed on 

the selected path. Star must be on top layer.

Object to path

Http://fairycut.com/videos/ObjectTopath/Object%20to%20path.swf


2) From the Document Bar, expand Shape menu and select 
Fit Objects to Path.

3) Check mark Full Path, the selected object(s) is distributed 
automatically on the full path.

4) Use the sliding button to adjust the distance between 
objects or type the desired value.

If the Full Path box is not activated you have to use the button 
(+) to add one by one objects to the path and the button (-) 
removes an object one by one. 

The other parameters define the distance of the first object 
added according to the beginning of the path and second 
parameter defines the distance of objects added from the path.

Use a common printer and paper to print the stencil for the 
position and the stones sizes.
Use a big needle to pierce holes position on the printed paper. 
Position of the paper stencil on the material.
Use a pencil to mark stones position on the material.
By means of the hot fix applicator poses the rhinestones onto 
the surface you want to embellish.

Application method #1

1) Print
2) Holes
3) Mark on
4) Applicator

Application method #2
Use a common printer and paper to print the stencil for the 
position and the stones sizes.
Place your printed paper pattern on a table or on a flat 
surface and tape the edge.
Remove the white backing from the clear Mylar sheet.  



Figure 1 Computer screen Fish mouth left

Figure 2 shows 
printed pattern fixed 
to the table with the 
adhesive tape.

(Separate the self-adhesive Mylar of its support)
Place the Mylar sheet directly over your printed paper pattern 
(sticky side up) and tape the edges of Mylar sheet to maintain 
over paper surface.

Place the crystals using tweezers (glue side up) to create the 
design printed on paper pattern.

When all crystals are in place, replace white backing over the 
crystals and remove tape.Your design is ready to be applied 
on your favorite itemJust rub slightly the surface to obtain a 
good adhesion of stones. Separate the Mylar containing 
stones and position on the garment or the wished material.

Manual application using a common household iron or a heat 
press.



Figure 3 Mylar sheet directly over your printed paper pattern 
(sticky side up) and tape the edge to maintain over paper 
surface. Rhinestones are face down and stick to Mylar sheet.

When 
the crystals and remove tape. Turn stencil upside down, 
mouth is on right side (Figure 4) and can be stored. Before 
to apply remove the white backing.

all crystals are in place, replace white backing over 

Figure 4 .Your design is ready to be applied



Application method #3

Using a vinyl cutter or a scrapbooking cutter c
rubber or plastic stencil material. 
Remove the stencil from it backing and position the stencil on 
stiff plastic plate, place the stencil stuck on the plate in a tray.
Pour stones on the stencil and by means of a small brush to 
scatter stones in the holes face upward.
Using the Mylar transfer, position it on the stone stencil surface 
and by means of a small squeegee scrape slowly so that 
stones stick to the Mylar without however to the stencil. 
Once made return the Mylar and stones on its backing support 
for storage or waiting production.

To produce: Separate the Mylar containing stones from it 
backing and position on the garment or the wished material.

Manual application using a common household iron or a heat 
press.

ut directly the 



1) Carefully remove the white backing from Mylar sheet
2) Position the Mylar sheet design onto fabric.
3) Place Teflon sheet over design.
3) Set your iron to the proper temperature for the material, and 
allow iron to heat thoroughly. 
- Make sure that steam is OFF
- Use “Wool Setting” 
4) Leave iron on design no pressure on and do not move iron, 
let it sit in place for approximately 12 - 15 seconds. Depending 
on fabric use less time for silks and more time for denim.
Large designs, heat one section at a time until all crystals are 
heated.  
5) Turn fabric over and press gently from the back.
6)  Allow to cool at least 3 to 5 minutes, slowly remove the 
Mylar sheet. 
7) When removing the Mylar sheet if some crystals are not 
firmly attached or feel “loose,” reapply the iron as above.

Women's T-Shirts

Chest

Waist

Women T Shirt

Bust 1” below 

armhole

S

15.5”

25.75”

M

16.5”

26.38”

L

17.75”

27”

XL

18.75”

27.63”

2XL

20.25”

28.75”

Short sleeve

Long sleeve

Sleeveless/Tanks

Iron-on the finished design




